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Exercise #1 – Enhancing an Existing Report
Part 1 – Make a Copy of the Template
1. Open Windows Explorer
2. Navigate to the following folder: C:\ProgramData\Event1\OC2\Reports
3. Click on JC Cost To Complete.xlt, press Ctrl + C , and then
press Ctrl + V .

Part 2 – Add a Drop-Down List for Jobs
In this part, you will add a simple drop-down list for the job number. The method used
here is just one of several ways to do this.
1. Right-click on JC Cost To Complete - Copy.xlt (copied in Part 1) and click
Open.
NOTE: You may see the following alert at the top of the window:

This comes up because, by default, Excel disables features of a workbook or template that could be
harmful if file is not from a trusted source. For example, Excel macros from an unknown publisher
could have malicious intent or the query text associated with data connections could expose sensitive
information or make unintended changes to your data.
Since this template is from a trusted publisher, click Enable Content.
FOR MORE INFORMATION: See the following knowledge base article:
http://kb.event1software.com/?p=45

2. Click the Admin worksheet.
3. Click in cell G5.
4. Click the Add-Ins tab on the ribbon.
5. Click

Query Wizard on the Office Connector toolbar.

6. In the Select Sage Timberline Office Company window, select Timberline
Construction and click OK.
7. Press Ctrl + F and type: jc job
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NOTE: When you click OK, the selection will move to the JC Job (1) table.

8. Click Next
9. In the JC Job (1) fields list, check the Job box and click Next.
10. Add a condition to exclude closed jobs
a. Click Add Condition
b. In the Field list, scroll down and select Status.
TIP: You can also type the first few letters of the field name (e.g., “st”) to jump to the first field starting
with that set of letters.

c. In the Comparison box, select Not equal.
d. In the Compare to box, select Literal Value for Value Type.
e. In the Value box, type: Closed
f. Click OK
11. Click Next
12. In the Layout box, uncheck Include field names
13. Click Finish
14. Click in cell C5
15. Click the Data tab on the ribbon
16. In the Data Tools group, click

Data Validation

NOTE: The Data Validation button is a button drop-down. This means you can click the button to
bring up the desired window or you can click the drop-down to see more options. If you click the dropdown, select the Data Validation option for this step.

17. In the Allow box, select List
18. In the Source box, type: =qryJCJob1
19. Click OK
20. Right-click on the column header for column G and click Hide
21. Test the drop-down list
a. Click the drop-down button in cell C5 and pick job 03-001.
b. Click in cell C7 and type: 5/31/2011
c. Click Refresh Report
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Part 3 – Write-Enable the Job Schedule
In this part you will add the capability for the user to update the job schedule and then
write the updated schedule dates back to the job record using Office Connector Write.
1. Click the Cost To Complete worksheet.
2. In the left margin of the worksheet, click the row expander + to show rows 6
through 9.
3. Select columns Q through AE, right-click, and click Unhide.
4. Click in cell V7
5. Click the Add-Ins tab of the ribbon
TIP: Prior to using the Write Wizard, you would ordinarily make note of the cell addresses (or names)
of cells containing the data you want to write. This way, when you scroll to the location where you will
insert the TSWrite functions and the cells containing the data are no longer visible, you’ve noted their
locations.

6. Click

Write Wizard on the Office Connector toolbar

7. In the list of tables, select JC Job(1) and click Next
8. Leave the selection on Modify Only and click Next
9. In the grid showing the Job key field, enter the following in the Value column and
click Next: JobID
NOTE: “JobID” is a defined name in this template that refers to Admin!E5. Rather than specifying
that the job number is in cell Admin!E5, you can therefore specify that it is in cell JobID, which is much
more understandable.

10. In the JC Job (1) fields list, check the following boxes and then click Next.
•
•
•

Estimated Start Date
Revised Start Date
Actual Start Date

11. In the Value column, supply the following values for these fields:
Estimated Start Date

N7

Revised Start Date

O7

Actual Start Date

P7

12. Click Finish.
13. Click in cell V8.
14. Click

Write Wizard on the Office Connector toolbar

15. In the list of tables, select JC Job(1) and click Next
16. Leave the selection on Modify Only and click Next
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17. In the grid showing the Job key field, enter the following in the Value column:
JobID
18. In the JC Job (1) fields list, check the following boxes and then click Next.
•
•
•

Estimated Comp Date
Revised Comp Date
Actual Complete Date

19. In the Value column, type the following values for these fields:
Estimated Comp Date

N8

Revised Comp Date

O8

Actual Complete Date

P8

20. Click Finish.
TIP: Look at the formulas in cells V7 through X8. Notice that they are all identical except for two
arguments; the field being written to, and the cell containing the data. If we had first placed the field
names in cells V1 through X2, we could have created one TSWrite formula in cell V7 and then copied
it across and down. The cell references, being relative, would have incremented and identified the
correct field names and cell values, producing the same results. When you have to create many
formulas that are very similar, this technique can save you time!

21. Select columns R through AD, right-click on the column header for column R,
and click Hide.
22. Select the range of cells from N7 to P8 (the schedule fields).
23. Click the Home tab of the ribbon.
24. In the Styles group, click the Cell Style named Data Entry.
NOTE: This step simply changed the style of the cells to indicate that they are available for data
entry. This also unchecks the Protected box so that these cells remain editable even if the worksheet
is protected.
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25. Test the newly added writing capability.
a. Click in cell O7 and type: 1/13/2011
b. Click in cell O8 and type: 11/15/2011
c. Click the Add-Ins tab of the ribbon
d. Click

Send Data to Timberline on the Office Connector toolbar

e. In the Approve Changes window, a list of the fields to be updated is
displayed. Review the list and then click Write.
NOTE: After the data has been written, a recap report will be displayed in your browser. This shows
a listing of each record and field tha was successfully updates as well as any issues that were
encountered. Afterwords, you will receive a prompt asking if you want to refresh data. This may be
beneficial if any of the queries or functions show the values that would have been updated because
you will be able to see the updated information after it has refreshed.
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Part 4 – Import-Enable the Misc Worksheet Values
In this part, you will add the capability to send the values from certain columns to job
cost miscellaneous worksheets. Since this involves the creation of transactions, Office
Connector Import will be utilized to create an import file.
1. Select columns Q through Y
2. Right click on the column-header for column Q and click Unhide
3. Click in cell T13
4. Click the Add-Ins tab of the ribbon
5. Click

Import Wizard on the Office Connector Import toolbar

6. In the Type of import list, select JC Misc Worksheet Import File and click Next
7. In the Transaction Columns list, check the box for the following columns and
then click Next:
•
•
•
•
•
•
•
•

Job
Extra
Cost Code
Transaction Type
Transaction Date
Description
Amount
Action

8. Click Link selected columns to cells in my worksheet
9. On the Job row, click the drop-down arrow in the Value column and select
JobID.
10. In the grid, supply the following values in the Value column:
Cell Reference

Column

Value



Extra

A13



Cost Code

B13



Transaction Type

MiscAmount3



Transaction Date

AsOfDate



Description

Q13



Amount

M13



Action

Replace

TIP: For the cell addresses, you can alternatively click the cell-selector on the far right edge of the
value column and click on the required cell. In the case of the Transaction Date, you can click the
drop-down and select AsOfDate since this is a named cell.
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11. Click Finish.
NOTE: You may receive the following pop-up notification:
The return value of the TSImport function can be useful for debugging a new workbook, but has
no practical value in everyday use.
It is a good practice to hide the TSImport columns prior to deploying a workbook to end users.
Unlike regular Excel functions that are intended to return a value that you want to see or use in some
way, the TSImport function acts as an instruction to Office Connector. It therefore doesn’t return a
useful value.

12. Click in cell U13
13. Click the Add-Ins tab of the ribbon
14. Click

Import Wizard on the Office Connector Import toolbar

15. In the Type of import list, select JC Misc Worksheet Import File and click Next
16. In the Transaction Columns list, check the box for the following columns:
•
•
•
•
•
•
•
•

Job
Extra
Cost Code
Transaction Type
Transaction Date
Description
Amount
Action

17. Click Link selected columns to cells in my worksheet
18. On the Job row, click the drop-down arrow in the Value column and select
JobID.
19. In the grid, supply the following values in the Value column:
Cell Reference

Column

Value



Extra

A13



Cost Code

B13



Transaction Type

MiscAmount2



Transaction Date

$B$6



Description

Q13



Amount

N13



Action

Replace

20. Click Finish.
21. Select cells T13 and U13 then double-click on the fill handle in order to copy the
formulas down to each row.
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NOTE: The fill-handle is the solid box in the lower-right corner of the cell: When you double-click this
box, the formula in the cell will be copied down.

Fill-Handle

22. Select columns R through X.
23. Right-click on the column-header for column R and click Hide.
24. Test the newly added import capability
a. Enter some numbers in column M (Cost To Complete)
b. Click the Add-Ins tab of the ribbon.
c. Click

Save Import File of the Office Connector Import toolbar

d. In the Import file box, the filename should be JCMWTran.txt and the
path will be your Sage Timberline Office data folder.
e. Select Launch Office Connector – Import Misc Worksheets
f. Click OK. If a notification pops up indicating that the file already exists,
click Replace.
NOTE: The following notification message may appear:
Note that the import task may default to the last used import file, which may not be the same
as the import file you just created. Please be sure to select the following file:
This means that Office Connector Import has created the import file using the name you provided but
to complete the importing of the data, another program is used. The program that imports the data
remembers the last filename that it was used with. If this filename is different than the one you just
created, you’ll need to make sure to select your file.

g. In the Import File box, type: JCMWTran.TXT
h. Click Import
NOTE: After the file has been imported, a recap report is displayed in your browser showing the
results of the import. This may include a list of records that were skipped because they contained
transactions with a zero amount (which is not allowed). A list of the transactions that were
successfully created will also be displayed.
NOTE: You might notice that the transaction amounts don’t match what you entered in the worksheet.
This is because we identified the “Replace” action. This causes transactions to be created that
represent the difference between the current value and the replacement value. The transaction
amonts you see are therefore the amounts that needed to be added or subtracted to the existing
values in the master file in order for them to equal the amounts on your worksheet.
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Part 5 – Save the Updated Template
1. Click the Information worksheet
2. Click in cell D45 and type: Revision 19-SUMMIT
3. Click in cell D46 and type today’s date and time.
4. Click the Admin worksheet.
5. Click in cell C5 and press the Delete key.
6. Click in cell C7 and type: 1/1/1901
NOTE: We use this date as the default rather than leaving the cell blank. This is because a blank is
not a valid date and may not work with the queries and functions in the template.

7. Click Refresh Data
8. Click File and then Save
9. You will receive a notice:
“This workbook contains external data. Do you want Microsoft Excel to
clear the data before saving the template and then automatically refresh
the data whenever the template is opened?”.
Click No.
NOTE: When saving the template, you may receive the following notice:

This is because the template was saved as an Excel 97-2003 Template so that it will be compatible
with current versions of Excel as well as Excel 2003. This notice is telling you that since you are using
a newer version of Excel, there are some formatting and other features that apply to the current
version of Excel, but not older versions. If you have used any styles or formatting that aren’t
supported by the older versions, they will therefore be lost. This window helps you identify potential
issus that you may want to address.
The alternative is to save the template in the native format of Excel 2007 and higher by selecting the
Excel Temlate file type.
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Exercise #2 – Job Profit Trend
In this exercise, you will build a trending report that displays the profitability that was
projected for a given job and how the weekly projections have changed over the past
twelve weeks. This analysis makes use of the cumulative contract value, estimate, and
change orders, as well as forecasted cost to complete values that may have been
entered or imported into Misc Worksheets each week.
The final step of the report includes the creation of a chart that graphically depicts the
trend in the profit projections:
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Part 1 – Start New Report
1. On the Windows Desktop, double-click Office Connector Launch Pad
2. Click the Reports tab
3. Double-click (New Report).xlt
NOTE: When building an Office Connector report, you are not required to start with this template.
You can start with a blank Excel workbook if you want. Using this template simply gives you a jumpstart on some of the report’s structure and styles.

4. In the Select Sage Timberline Office Company window, select Timberline
Construction and click OK
5. Click the Report worksheet
6. Select rows 5 through 13, right-click on one of these row labels, and then click
Delete
7. Click in cell A1 and type: Job Profit Trend

Part 2 – Create Parameter Cells
1. Click in cell A5 and type: Job Number: Enter .
2. Click in cell D5 and then in the Name Box, type: JobNumber Enter .
TIP: The Name Box is located in the upper left corner of the worksheet. The cell address of the
selected cell is normally displayed here. To assign a name to a cell, you can click inside this box, type
a name, and press Enter. Later, you can refer to the cell (in formulas for example) using its name
rather than its cell address.

3. While still in cell D5, type: 03-001
4. Click in cell A6 and type: As Of Date:
5. Click in cell D6 and then in the Name Box, type: AsOfDate
6. While still in cell D6, type: 5/31/2011
7. Select cels D5 and D6, then in the Styles group (of the Home tab) click the Cell
Style named Data Entry
NOTE: The Data Entry style exists to provide an easy visual means to identify the cells where the
user is intended to type. When the worksheet is protected, the Data Entry cells will remain
unprotected.
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Part 3 – Add 12-Month Column Captions
1. Click in cell O8 and type: =AsOfDate
NOTE: If cell O8 displays a number (e.g., 40694), this is because Excel doesn’t know yet that the
cell should be formatted as a date. Dates are actually stored as numbers behind the scenes and so
the number 40694 represents the number of days that have elapsed since January 1, 1900. To format
this value as a date, right-click the cell, click Format Cells and then choose the first date format.

2. Click in cell N8 and type: =O8-7
3. Copy the formula that is in cell N8 to cells D8 through M8

Part 4 – Add Row Labels
1. Type the following labels into these cells:
10
11
12
13
14
15
16

A
Original Contract
Approved Changes
Revised Contract

B
Scheduled value
Aprvd schdl val chng

Original Estimate
Approved Changes
Total Estimate

Original estimate
Approved est changes

NOTE: The values in column B are being used to identify the applicable transaction types for each
row. Make very certain to enter these values exactly as shown here (with attention to the use of upper
and lower case characters).

2. Click in cell A18.
3. Click the Add-Ins tab of the ribbon.
4. Click

Query Wizard on the Office Connector toolbar.

5. Select the table named JC Standard Category and click Next
6. In the JC Standard Category fields list, check the following boxes:
•
•
•

Category
Description
Accumulate As

7. Click Finish
8. Select cells B18 through B27 (the entire contents of the Description column).
9. Right-click and click Cut
10. Click in cell C18, right-click, and then click Insert Cut Cells
11. Click in cell A30 and type: Forecasted Cost At Completion
12. Click in cell B30 and type: Misc worksheet 2
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13. Click in cell A32 and type: Projected Cost
14. Click in cell A34 and type: Projected Profit

Part 5 – Add Contract and Estimate Amounts
1. Click in cell D10.
2. Click

Sum Wizard on the Office Connector toolbar.

3. Select the table having JC Transaction in the Table column and
CURRENT.JCT in the File column, and click Next
4. In the JC Transaction fields list, check the Amount box and click Next
5. Add a condition for the Job Number
a. Click Add Condition
b. In the Field list, select Job
c. In the Comparison box, select Equal
d. In the Compare to box, select Cell Reference for the Value Type
e. Click the drop-down in the Value box and select JobNumber
f. Click OK
6. Add a condition for the As Of Date
a. Click Add Condition
b. In the Field list, select Transaction Date
c. In the Comparison box, select Less or equal
d. In the Compare to box, select Cell Reference for the Value Type
e. In the Value box, type: D$8
TIP: Make sure to enter the dollar sign in the correct place. This way, when the formula is copied, the
row number in the copies won’t change.

f. Click OK
7. Add a condition for the transaction type
a. Click Add Condition
b. In the Field list, select Transaction Type
c. In the Comparison box, select Equal
d. In the Compare to box, select Cell Reference for the Value Type
e. In the Value box, type: $B10
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TIP: Make sure to enter the dollar sign in the correct place. This way, when the formula is copied, the
column letter in the copies won’t change.

f. Click OK
8. Click Finish
9. Copy the formula in cell D10 to the following ranges of cells:
•

D10:O11

•

D14:O15

•

D30:O30

10. Using Excel’s SUM function add totals on rows 12 and 16 for columns D through
O

Part 6 – Add Cost Amounts
1. Click in cell D19.
2. Click the

Sum Wizard on the Office Connector toolbar

3. Select the table having JC Transaction in the Table column and
CURRENT.JCT in the File column, and click Next
4. In the JC Transaction fields list, check the Amount box and click Next
5. Add a condition for the Job Number
a. Click Add Condition
b. In the Field list, select Job
c. In the Comparison box, select Equal
d. In the Compare to box, select Cell Reference for the Value Type
e. Click the drop-down in the Value box and select JobNumber
f. Click OK
6. Add a condition for the As Of Date
a. Click Add Condition
b. In the Field list, select Accounting Date
c. In the Comparison box, select Less or equal
d. In the Compare to box, select Cell Reference for the Value Type
e. In the Value box, type: D$8
f. Click OK
7. Add a condition for the transaction type
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a. Click Add Condition
b. In the Field list, select Transaction Type
c. In the Comparison box, select Like
d. In the Compare to box, select Literal Value for the Value Type
e. In the Value box, type: __ cost
NOTE: The value consists of two consequitive underscore characters, followed by a space, and then
followed by the word “cost” in lower case. Each underscore character represents a single-character
wildcard that can be any letter or number. This means that transaction types like “AP cost”, “EQ
cost”,” IV cost”, “JC cost”, “PR cost”, “SM cost” will all match the criteria.

f. Click OK
8. Add a condition for the category
a. Click Add Condition
b. In the Field list, select Category
c. In the Comparison box, select Equal
d. In the Compare to box, select Cell Reference for the Value Type
e. In the Value box, type: $B19
f. Click OK
9. Click Finish
10. Copy the formula from cell D19 to all cells in the range D19:O27
11. Click in cell A28 and type: JTD Cost
12. Using Excel’s SUM function, add totals for rows 19 through 27 in columns D
through O

Part 7 – Add formula for Projected Cost and Profit
1. Click in cell D32 and type: =MAX(D28,IF(D30<>0,D30,D16))
NOTE: The IF function in this formula checks to see if a forecasted cost-to-complete value was
entered. If so, that value is used, but if not, the total estimate is used. In either case, if the job to date
cost is greater, then the job to date cost will be used (due to the MAX function).

2. Copy the formula from cell D32 to cells E32 through O32
3. Click in cell D34 and type: =D12-D32
4. Copy the formula from cell D34 to cells E34 through O34
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Part 8 – Hide columns
1. Select columns B and C
2. Change the background color to a medium gray
TIP: Giving columns that you intend to leave hidden a different color will help you know which
columns you may later need to re-hide if you do future work on the report.

3. Right click on the column label for column B or C and then click Hide

Part 9 – Create a Profit Trend Graph
1. At the bottom of the workbook click

to add a new worksheet

2. Right-click on the tab for the new sheet, click Rename, and then type: Trend
Graph
3. Click on the Report worksheet
4. Select cells D8 through O8
5. While holding down the Ctrl key, click on cell D34 and drag the mouse pointer
to the right, stopping at cell O34.
6. Click the Insert tab of the ribbon
7. In the Charts group, select the first 2-D Line chart.
8. Right-click on the edge of the newly created chart and click Cut
9. Click on the Trend Graph worksheet
10. Right-click in cell A1 and click Paste
11. Using the lower-right grab-handle of the chart, expand its size to fill most of the
screen.
12. Right-click on the blue-line that represents “Series 1” and click Format Data
Series
13. Click Line Style
14. In the Width box, type: 6 pt
15. For the End type, select 
16. For the End size, select the largest size
17. Check Smoothed line
18. Click Close
19. Right-click the Series 1 label and click Select Data
20. In the Legend Entries (Series) box, click Edit and then in the Series name box,
type: =”Projected Profit”
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21. Click OK and then OK again to dismiss the windows
22. Right-click the Admin worksheet and click Delete. Click Delete agin in the popup notice asking you to confirm that you want to permanently delete the data.
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Part 10 – Test Your Report
1. Click on the Report worksheet and enter different job numbers to see how the
results change:
•
•
•

03-001
03-002
03-003

Part 11 – (Optioal) Pie Chart for Cost Types
1. Click in cell D18 of the Report worksheet and type: Week 1
2. Click in cell D18 and then click down on the fill-handle and drag the mouse
pointer to the right, stopping at cell N18, and then release the mouse button.
TIP: This technique will automatically create column labels of Week 1 through Week 11.

3. Click in cell O18 and type: Current
4. Unhide column C
5. Select cells C18 through O27
6. Click the Insert tab of the ribbon
7. Click the PivotTable drop-down button and click PivotChart
8. Click OK to accept the default options
9. In the PivotTable Field List box, check the boxes for Accumulate As and
Current
10. Right-click on the edge of the chart and click Change chart type
11. Click Pie, click the first pie chart type shown, and then click OK
12. In the Chart Layouts group of the Design tab, the first option (having a tool-tip
of Layout 1):

13. Rename the newly created chart worksheet as: Cost Type Summary
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Part 12 – (Optional) Boost Performance
As built so far, each TSSUM function will trigger Office Connector to subit a query to the
database that will return the requested value. Since there are a number of TSSUM functions in
the worksheet, this means that several “round-trips” between your workstation and the server
will occur. By replacing the table argument (“CURRENT_JCT_RECORD_1”) with a prepared
SQL statement, we can tell Office Connector up-front what subset of data we are going to work
with. That data is then copied into memory so that each TSSUM function has it immediately
available when each formula is calculated. This reduces the number of “round-trips” to the
server and increases the performance of the report.
TIP: In almost all cases, the table argument of any Office Connector function can be replaced with a
SQL statement. The result of the SQL statement is treated like a hidden table that resides in memory.

1. Click the SQL worksheet
2. Click in cell B6 and type: sqlJobTrans
3. Click in cell B7 andtype:
="SELECT TJOB, TCAT, TRANTYP, TRANDAT, TACTDAT, TAMOUNT FROM
CURRENT_JCT_RECORD_1 WHERE TJOB='" & JobNumber & "' AND TRANTYP
IN ('Scheduled value', ' Aprvd schdl val chng', ' Original
estimate', ' Approved est changes', ' Misc worksheet 2') OR
TRANTYP LIKE '__ cost'"
NOTE: The above formula returns a SQL statement that, when executed, returns a table containing
transactions for the specified job and only the specific columns needed by this report.

4. Click cell B7 and then click in the Name Box and type: sqlJobTrans
5. Click the Report worksheet
6. Press Ctrl + H to bring up the Find and Replace window
7. In the Find what box, type: "CURRENT_JCT_RECORD_1"
8. In the Replace with box, type: sqlJobTrans
9. Click Replace All
10. Click Close in the Find and Replace window
11. Click in cell D19 and press F2 .
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12. Use the left arrow key to move to the following section: LIKE '__ cost'
Change this
•

From: LIKE '__ cost'

•

To: LIKE '*cost*'

NOTE: Since the data is being filtered on the workstation and not by the server, a slight syntax
change is required regarding the use of the wildcard charcters.

13. Copy the formula from cell D19 to the cell in the range of D19:O27
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Exercise #3 – Subcontractor Application For
Payment
In this exercise you will create an Excel-based solution that can be used to automate
payment applications from subcontractors. Current values for a given subcontract are
queried to produce a billing worksheet. This can be sent to a subcontractor for
completion (using a free viewer license of Office Connector on their end). Once the
subcontractor has entered their billing amounts, the workbook can be sent back and
then imported into Accounts Payable.
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Part 1 – Start New Report
1. On the Windows Desktop, double-click Office Connector Launch Pad
2. Click the Reports tab
3. Double-click (New Report).xlt
NOTE: When building an Office Connector report, you are not required to start with this template.
You can start with a blank Excel workbook if you want. Using this template simply gives you a jumpstart on some of the report’s structure and styles.

4. In the Select Sage Timberline Office Company window, select Timberline
Construction and click OK

Part 2 – Create Parameter Cells
1. Click the Admin worksheet
2. Delete rows 4 through 6
3. Delete rows 8 through 12
4. Click in cell B4 and type the following formula: =TSCustomCaption("%20")
NOTE: The TSCustomCaption function returns the customized caption for a specific field. In this
case, field code %20 identifies the Commitment field which can be renamed in the Custom
Descriptions window.

5. Click in cell D4 and then in the Name Box, type: CommitmentID
6. In cell D4, type the value: 2317

Part 3 – Start the Report
1. Click the Report worksheet
2. Delete rows 5 through 13
3. Click in cell A1 and type: Subcontractor Application For Payment
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Part 4 – Add a Query for the Schedule of Values
1. Click in cell A10
2. Click the Add-Ins tab of the ribbon
3. Click

Query Wizard on the Office Connector toolbar

4. Select the JC Commitment Item table and click Next
5. In the JC Commitment item fields list, check the following boxes and then click
Next
•
•
•
•
•
•

Item Number
Description
Amount
Commitment CO
Approved commitment CO Amount
Amount Invoiced

6. Add a condition for the Commitment ID
a. Click Add Condition
b. In the Field list, select Commitment
c. In the Comparison box, select Equal
d. In the Compare to box, select Parameter in the Value Type drop-down
e. In the Value box, click the drop-down and select CommitmentID
f. Click OK
7. Click Next
8. Click Finish

Summit Conference 2012

25 of 33

Session Code: C-0641

Excel-Based Information Management

9. Change the column captions of the query
a. Click

SQL Editor on the Office Connector toolbar

Change From:

Chagne To:

SELECT
"ITEM" AS "Item Number",
"IDESC" AS "Description",
"IAMT" AS "Amount",
"ICO" AS "Commitment CO",
"IAPPCOA" AS "Approved commitment
CO Amount",
"IAMTINV" AS "Amount Invoiced"

SELECT
"ITEM" AS "Item Number",
"IDESC" AS "Description",
"IAMT" AS "Original Contract",
"ICO" AS "CO#",
"IAPPCOA" AS "Approved Changes",
"IAMTINV" AS "Previously Billed"

FROM
"MASTER_JCM_RECORD_13"

FROM
"MASTER_JCM_RECORD_13"
WHERE
"ISUB"=?

WHERE
"ISUB"=?

b. Click Save
10. Click the column letter for column D , then right-click on it and click Cut
11. Click the column letter for column B , then right-click on it and click Insert Cut
Cells

Part 5 – Add Formula Columns
1. Click the column letter for column F , then right-click on it and click Insert
2. Revised Contract Column
a. Click in cell F10 and type: Revised Contract
b. Click in cell F11 and type: =D11+E11
c. Double-click the fill-handle in cell F11 to copy the formula down to each
row
3. Billed This Period Column
a. Click in cell H10 and type: Billed This Period
b. Click in cell H11 and type: =0
c. Double-click the fill-handle in cell H11 to copy the formula down to each
row
d. Select the cells in this column (starting with H11 through the last row)
e. Click the Home tab on the ribbon
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f. In the Styles group, click on the Cell Style named Data Entry
4. Total Billed Column
a. Click in cell I10 and type: Total Billed
b. Click in cell I11 and type: =G11+H11
c. Double-click the fill-handle in cell I11 to copy the formula down to each
row
5. Percent Billed Column
a. Click in cell J10 and type: % Billed
b. Click in cell J11 and type: =IF(F11<>0,I11/F11,0)
c. Double-click the fill-handle in cell J11 to copy the formula down to each
row
d. Format the values in column J as Percent.
6. Balance To Bill Column
a. Click in cell K10 and type: Balance To Bill
b. Click in cell K11 and type: =F11-I11
c. Double-click the fill-handle in cell K11 to copy the formula down to each
row
7. Retainage Column
a. Click in cell G6 and type: Retainage %
b. Click in cell H6.
c. Click

Lookup Wizard on the Office Connector toolbar

d. Select the JC Commitment table and click Next
e. In the Value column (for Commitment), type: CommitmentID
f. Click Next
g. Check the Retainage Percent box and click Finish
h. Click cell H6 and then in the Name Box, type: RetainagePct
i. Click in cell L10 and type: Retainage (This Invoice)
j.

Click in cell L11 and type: =H11*RetainagePct
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Part 6 – Add Totals
1. Navigate to the second blank row following the list of commitment items (i.e., row
36)
2. Place an Excel SUM function on this row for columns D through I and columns K
through L.
3. On the total row for column J, copy the formula from cell J11

Part 7 – Create the Report Heading
1. Show Commitment Information
a. Click in cell A5 and type: =TSCustomCaption("%20")
b. Click in cell B5 and type: =CommitmentID
c. Click in cell C5.
d. Click the Add-Ins tab of the ribbon
e. Click

Lookup Wizard on the Office Connector toolbar

f. Select the JC Commitment table and click Next
g. In the Value column (for Commitment), type: CommitmentID
h. Click Next
i. Check the box for the following columns and then click Finish
• Description
• Vendor
• Job
2. Show Vendor information
a. Click in cell A6 and type: Vendor
b. Click in cell D5 and press Ctrl + C .
c. Click in cell B6 and press Ctrl + V .
d. While still in cell B6, click in the Name Box, and type: VendorID
e. Click in cell C6.
f. Click

Lookup Wizard on the Office Connector toolbar

g. Select the AP Vendor table and click Next
h. In the Value column (for Vendor), type: VendorID
i. Check Name and click Finish

Session Code: C-0641

28 of 33

Sage Summit 2012

Excel-Based Information Management

3. Show Job information
a. Click in cell A7 and type: Job
b. Click in cell E5 and press Ctrl + C .
c. Click in cell B7 and press Ctrl + V .
d. While still in cell B7, click the Name Box, and type: JobID
e. Click in cell C7
f. Click

Lookup Wizard on the Office Connector toolbar

g. Select the JC Job table and click Next
h. In the Value column (for Job), type: JobID
i. Check Description and click Finish
4. Add data entry cells for invoice information
a. Click in cell D5 and type: Invoice
b. Click in cell D6 and type: Date
c. Click the Home tab of the ribbon
d. Select cells E5 and E6 and then in the Styles group, click on the Cell
Style named Data Entry
5. Include the total invoice amount
a. Click in cell G5 and type: Amount
b. Click in cell H5 and type: =H36

Summit Conference 2012

29 of 33

Session Code: C-0641

Excel-Based Information Management

Part 8 – Import-Enable the Report
1. Add an import instruction for the invoice record
a. Click in cell M5
b. Click

Import Wizard on the Office Connector toolbar

c. In the Type of Import list, select AP Invoice Import File and click Next
d. In the Record Types list, select Invoice and click Next
e. In the Invoice Columns list, check the following boxes and then click
Next:
• Vendor
• Invoice
• Description
• Amount
• Invoice Date
• Accounting Date
f. Click Link selected columns to cells in my worksheet
g. Complete the grid as follows:
Cell
Reference

Column

Value



Vendor

VendorID



Invoice

$E$5



Description

$C$5



Amount

$H$5



Invoice Date

$E$6



Accounting Date

$E$6

h. Click Finish
i. Click cell M5, click in the Name Box, and then type: InvoiceRecord
2. Add an import instruction for the first distribution record
a. Click cell M11
b. Click

Import Wizard on the Office Connector toolbar

c. In the Type of Import list, select AP Invoice Import File and click Next
d. In the Record Types list, select Distribution and click Next

Session Code: C-0641

30 of 33

Sage Summit 2012

Excel-Based Information Management

e. On the Parent Record setup, click the drop-down, select InvoiceRecord,
and click Next
f. In the Distribution Columns list, check the following boxes and then click
Next:
• JC Commitment
• JC Commitment Line Item
• Amount
• Retainage
• Description
g. Click Link selected columns to cells in my worksheet
h. Complete the grid as follows:
Cell
Reference

Column

Value



JC Commitment

CommitmentID



JC Commitment Line Item

$A11



Amount

$H11



Retainage

$L11



Description

$C11

i. Click Finish
j.

Click in cell M11 and then click

(on the formula bar at the top)

k. In the FileDefinition box, type: IF($H11<>0,"APInvoice","")
NOTE: This formula change causes the first argument of the TSImport function to be blank (“”) when
the billing amount (column H) is zero. When the first argument is blank, Office Connector Import skips
that particular instruction. This way, line items that have no billing amount will not result in an invoice
distribution record being created.

l. Double-click the fill-handle in cell M5 to copy the formula down to all rows
3. Right-click the column label for column M and click Hide
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Part 9 – Edit Preferences
1. Click the Add-Ins tab on the ribbon.
2. Click

Edit Preferences on the Office Connector toolbar

3. Click This Workbook
4. Check Save data with report
NOTE: This causes data values in the report to be stored with the workbook so that a live database
connection is not needed in order to open the workbook later. For users (such as external
subcontractors) who do not own Sage Timberline Office, the Office Connector software can be
installed and used in a Viewer mode (with no purchase required) so that the stored data will be
displayed.

5. Click OK

Part 10 – Save and Test
1. Save the workbook
2. Enter values for Invoice and Date as well as dollar amounts in the Billed This
Period column
3. Click

Save Import File on the Office Connector toolbar

4. Complete the steps necessary to import the file into Accounts Payable
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Special Icons
Use the following special icons to call out information. Delete this page when you are finished.
NOTE: Enter the text of the note here.

WARNING: Enter the text of the warning here.

FOR MORE INFORMATION: Enter the text of the reference here.

TIP: Enter the text of the tip here.
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